
 

Model 4200-SCS-PK2 Quick Start Guide  



 

  

Safety precautions 
Observe the following safety precautions before using this product and any associated 
instrumentation. Although some instruments and accessories would normally be used 
with nonhazardous voltages, there are situations where hazardous conditions may be 
present. 
This product is intended for use by qualified personnel who recognize shock hazards 
and are familiar with the safety precautions required to avoid possible injury. Read and 
follow all installation, operation, and maintenance information carefully before using the 
product. Refer to the user documentation for complete product specifications. 
If the product is used in a manner not specified, the protection provided by the product 
warranty may be impaired. 
The types of product users are: 
Responsible body is the individual or group responsible for use and maintenance of 
equipment, for ensuring that the equipment is operated within its specifications and 
operating limits, and for ensuring that operators are adequately trained. 
Operators use the product for its intended function. They must be trained in electrical 
safety procedures and proper use of the instrument. They must be protected from 
electric shock and contact with hazardous live circuits. 
Maintenance personnel perform routine procedures on the product to keep it 
operating properly, for example, setting the line voltage or replacing consumable 
materials. Maintenance procedures are described in the user documentation. The 
procedures explicitly state if the operator may perform them. Otherwise, they should be 
performed only by service personnel. 

Service personnel are trained to work on live circuits, perform safe installations, and 
repair products. Only properly trained service personnel may perform installation and 
service procedures. 
Keithley Instruments products are designed for use with electrical signals that are rated 
Measurement Category I and Measurement Category II, as described in the 
International Electrotechnical Commission (IEC) Standard IEC 60664. Most 
measurement, control, and data I/O signals are Measurement Category I and must not 
be directly connected to mains voltage or to voltage sources with high transient 
overvoltages. Measurement Category II connections require protection for high 
transient overvoltages often associated with local AC mains connections. Assume all 
measurement, control, and data I/O connections are for connection to Category I 
sources unless otherwise marked or described in the user documentation. Main supply 
voltage fluctuations not to exceed ±10% of the nominal voltage. 
Exercise extreme caution when a shock hazard is present. Lethal voltage may be present 
on cable connector jacks or test fixtures. The American National Standards Institute 
(ANSI) states that a shock hazard exists when voltage levels greater than 30 V RMS, 
42.4 V peak, or 60 V DC are present. A good safety practice is to expect that hazardous 
voltage is present in any unknown circuit before measuring. 
Operators of this product must be protected from electric shock at all times. The 
responsible body must ensure that operators are prevented access and/or insulated from 
every connection point. In some cases, connections must be exposed to potential 
human contact. Product operators in these circumstances must be trained to protect 
themselves from the risk of electric shock. If the circuit is capable of operating at or 
above 1000 V, no conductive part of the circuit may be exposed. 



 

 

Do not connect switching cards directly to unlimited power circuits. They are intended 
to be used with impedance-limited sources. NEVER connect switching cards directly to 
AC mains. When connecting sources to switching cards, install protective devices to 
limit fault current and voltage to the card. 
Before operating an instrument, ensure that the line cord is connected to a 
properly-grounded power receptacle. Inspect the connecting cables, test leads, and 
jumpers for possible wear, cracks, or breaks before each use. 
When installing equipment where access to the main power cord is restricted, such as 
rack mounting, a separate main input power disconnect device must be provided in 
close proximity to the equipment and within easy reach of the operator. 
For maximum safety, do not touch the product, test cables, or any other instruments 
while power is applied to the circuit under test. ALWAYS remove power from the 
entire test system and discharge any capacitors before: connecting or disconnecting 
cables or jumpers, installing or removing switching cards, or making internal changes, 
such as installing or removing jumpers. 
Do not touch any object that could provide a current path to the common side of the 
circuit under test or power line (earth) ground. Always make measurements with dry 
hands while standing on a dry, insulated surface capable of withstanding the voltage 
being measured. 
The instrument and accessories must be used in accordance with its specifications and 
operating instructions, or the safety of the equipment may be impaired. 
Do not exceed the maximum signal levels of the instruments and accessories, as defined 
in the specifications and operating information, and as shown on the instrument or test 
fixture panels, or switching card. 
When fuses are used in a product, replace with the same type and rating for continued 
protection against fire hazard. 

Chassis connections must only be used as shield connections for measuring circuits, 
NOT as safety earth ground connections. 
If you are using a test fixture, keep the lid closed while power is applied to the device 
under test. Safe operation requires the use of a lid interlock. 

 
If a screw is present, connect it to safety earth ground using the wire 
recommended in the user documentation. 

 
This symbol on an instrument means caution, risk of danger. The user should refer 
to the operating instructions located in the user documentation in all cases where 
the symbol is marked on the instrument. 

 
This symbol on an instrument means caution, risk of electric shock. Use standard 
safety precautions to avoid personal contact with these voltages. 

 
This symbol on an instrument shows that the surface may be hot. Avoid personal 
contact to prevent burns. 

 
This symbol indicates a connection terminal to the equipment frame. 

 
If the mercury symbol is on a product, it indicates that mercury is present in the 
display lamp. Please note that the lamp must be properly disposed of according to 
federal, state, and local laws. 

WARNING This heading in the user documentation explains dangers that might result 
in personal injury or death. Always read the associated information very 
carefully before performing the indicated procedure. 

CAUTION This heading in the user documentation explains hazards that could 
damage the instrument. Such damage may invalidate the warranty. 

Instrumentation and accessories shall not be connected to humans. 
Before performing any maintenance, disconnect the line cord and all test cables. 



 

  

To maintain protection from electric shock and fire, replacement components in mains 
circuits - including the power transformer, test leads, and input jacks - must be 
purchased from Keithley Instruments. Standard fuses with applicable national safety 
approvals may be used if the rating and type are the same. Other components that are 
not safety-related may be purchased from other suppliers as long as they are equivalent 
to the original component (note that selected parts should be purchased only through 
Keithley Instruments to maintain accuracy and functionality of the product). If you are 
unsure about the applicability of a replacement component, call a Keithley Instruments 
office for information. 
To clean an instrument, remove power from the instrument. Use a damp cloth or mild, 
water-based cleaner. Clean the exterior of the instrument only. Do not apply cleaner 
directly to the instrument or allow liquids to enter or spill on the instrument. Products 
that consist of a circuit board with no case or chassis (e.g., a data acquisition board for 
installation into a computer) should never require cleaning if handled according to 
instructions. If the board becomes contaminated and operation is affected, the board 
should be returned to the factory for proper cleaning and servicing. 
 
 
 
 

Power and environmental specifications 
For indoor use only. 

Power supply 100 V to 240 V AC, 50 Hz to 60 Hz 
Maximum VA 1000 VA 
Operating altitude Maximum 2000 m above sea level 
Operating 
temperature 

10 °C to 40 °C, 5% to 80% relative humidity non-condensing 

Storage 
temperature 

−15 °C to +60 °C, 5% to 90% relative humidity 
non-condensing 

 
Carefully consider and configure the appropriate output-off state, 
and source and compliance levels before connecting the 
instrument to a device that can deliver energy. Failure to consider 
the output-off state, and source and compliance levels may result 
in damage to the instrument or to the device under test. 

 



 

 

Introduction 
The easy-to-use Model 4200-SCS Semiconductor Characterization 
System performs lab grade DC and pulse device characterization, 
real-time plotting, and analysis with high precision and sub-femtoamp 
resolution. The 4200-SCS offers the most advanced capabilities 
available in a fully integrated characterization system, including a 
complete, embedded computer with a Microsoft Windows operating 
system and mass storage. Its self-documenting, point-and-click 
interface speeds and simplifies the process of taking data, so users 
can begin analyzing their results sooner. 

CD-ROM contents 
The CD-ROM that is included with your instrument contains: 

 Installation files for KITE. These can only be installed on the 
Model 4200-SCS. 

 Manuals & Specs. PDFs of the User Manual, Reference 
Manual, Technical Data, and Quick Start Guide documents. 

 Release Notes. The latest software release notes and license 
agreement. 

 Application Notes. Application notes that demonstrate specific 
applications. 

 Technical Notes. Specific technical information. 
 White Papers. General discussions of testing. 
 Data Sheets. Data sheets for the 4200-SCS and related 

equipment. This also includes brochures and other information. 
For additional support information, see 
http://www.keithley.com/support. 

http://www.keithley.com/support


 

  

Unpack and inspect the instrument 
To unpack and inspect the instrument: 
1. Inspect the box for damage. 

2. Open the top of the box. 
 

3. Remove the bag that contains the documentation, standard 
accessories, CD-ROMs, and optional accessories (such as 
rack-mount hardware). 

4. Remove the packaging insert. 

5. Remove the 4200-SCS from the bottom. 

 
Do not lift the 4200-SCS from the front bezel. Lifting the 
instrument by the front bezel can cause instrument damage. 

6. Inspect the instrument for any obvious signs of physical damage. 
Report any damage to the shipping agent immediately. 

 
 



 

 

In the 4200-SCS-PK2 bundle, you should have received the Model 
4200-SCS Semiconductor Characterization System, with:  
 Model 4200-SMU medium power SMUs (two) 
 Model 4210-CVU CVU module 
 Keyboard with integrated mouse 
 Model 4200-SCS KTE Interactive CD 
 Power line cord 

Also included should have been the accessories in the photograph: 
1 Model 4200-SCS-PK2 Quick Start Guide (this document) 
2 Model 8101-PIV component test fixture with sample devices 
3 Model 4200-RPC remote PreAmp cable 
4 Model 4200-MTRX ultra low noise SMU triaxial cables (two) 
5 Model 236-ILC-3 safety interlock cable 
6 Model 4200-PA remote PreAmp 
7 Model 4200-TRX ultra low noise PreAmp triaxial cables (two) 
8 CA-447A SMA cables, male to male (four) 
9 CS-701 BNC tee adapters (two) 
10 CS-1247 SMA female to BNC male adapters (four) 
11 CS-1252 SMA male to BNC female adapters (two) 
12 CAP-31 protective caps with triaxial connectors (two) 

13 Model 4200-SCS User's Manual 
Refer to the packing list for additional items that might have shipped 
with your instrument. 
 

 
 



 

  

Connect the instrument 

Important test system safety information 
This system contains instruments that can produce hazardous 
voltages. It is the responsibility of the test system installer, 
maintenance personnel, and service personnel to make sure the 
system is safe during use and is operating properly. You must also 
realize that in many test systems a single fault, such as a software 
error, may output hazardous signal levels even when the system 
indicates that there is no hazard present. It is important that you 
consider the following factors in your system design and use: 

 The international safety standard IEC 61010-1 defines voltages as 
hazardous if they exceed 30 V RMS and 42.4 V peak, or 60 V DC 
for equipment rated for dry locations. Keithley Instruments, Inc. 
products are only rated for dry locations. 

 Read and comply with the specifications of all instruments in the 
system. The overall allowed signal levels may be constrained by 
the lowest rated instrument in the system. For example, if you are 
using a 500 V power supply with a 300 V DC rated switch, the 
maximum allowed voltage in the system is 300 V DC. 

 Make sure any test fixture connected to the system protects the 
operator from contact with hazardous voltages, hot surfaces, and 
sharp objects. Use shields, barriers, insulation, and safety 
interlocks to accomplish this. 

 Cover the device under test (DUT) to protect the operator from 
flying debris in the event of a system or DUT failure. 

 Double-insulate all electrical connections that an operator can 
touch. Double insulation ensures the operator is still protected 
even if one insulation layer fails. Refer to IEC 61010-1 for 
specific requirements. 



 

 

 Make sure all connections are behind a locked cabinet door or 
other barrier. This protects the system operator from accidentally 
removing a connection by hand and exposing hazardous voltages. 
Use high-reliability fail-safe interlock switches to disconnect 
power sources when a test fixture cover is opened. 

 Where possible, use automatic handlers so operators are not 
required to access the DUT or other potentially hazardous areas. 

 Provide training to all users of the system so they understand all 
potential hazards and know how to protect themselves from 
injury. 

 In many systems, during power up, the outputs may be in an 
unknown state until they are properly initialized. Make sure the 
design can tolerate this situation without causing operator injury 
or hardware damage. 

  
To keep users safe, always read and follow all safety warnings 
provided with each of the instruments in your system. 

 

Install the instrument 
The Model 4200-SCS can be used on a bench or in a rack. Please see 
the instructions that came with your rack-mount kit if you are 
installing the Model 4200-SCS in a rack. 

Wiring the interlock 

The Model 4200-SCS is provided with an interlock circuit that 
must be positively activated for the high voltage output to be 
enabled. The interlock facilitates safe operation of the equipment 
in a test system. Bypassing the interlock could expose the 
operator to hazardous voltages that could result in personal 
injury or death. 
Asserting the interlock allows the SMU and preamp terminals to 
become hazardous. SMU and preamp terminals should be 
considered hazardous even if the outputs are programmed to be 
low voltage. Precautions must be taken to prevent a shock 
hazard by surrounding the test device and any unprotected 
leads (wiring) with double insulation for 250 volts, Category I. 
See EN61010-1 safety standards for details. 



 

  

If you need voltages greater than ±40 volts for testing, you must add 
an interlock switch to the fixture. This ensures that hazardous 
voltages are not present when the exterior enclosure of the fixture is 
open. It also enables the Model 4200-SCS to output higher voltages 
when the exterior enclosure of the fixture is closed. 

When the safety interlock signal is asserted (the switch is closed and 
the signal is connected to +12 V), all the voltage ranges of the SMUs 
are functional. When the safety interlock signal is not asserted (the 
switch is open), the 200 V range on the SMUs is disabled, limiting the 
nominal output to ±40 V.  

If you need voltages of greater than ±40 volts, you must also connect 
the exterior of the test fixture enclosure to protective earth (safety 
ground). Take care to ensure that the wiring (FORCE, GUARD, and 
SENSE) in the fixture does not electrically contact the exterior 
enclosure. 

There are low voltage and high voltage test fixtures for the Model 
4200-SCS. Low voltage fixtures, such as the Model 8101-PIV that is 
included with this bundle, are intended for applications that are less 
than ±40 volts. For these applications, an interlock is not needed. 

High-voltage test fixtures, such as the Keithley Instruments LR8028, 
can be used with applications that are greater than ±40 volts. The test 
fixture has a safety interlock switch connected to its lid. When the lid 
is closed, the interlock circuit is closed (asserted), and SMU ±200 V 
ranges are enabled. Conversely, the interlock circuit is open (de-
asserted) when the lid is open, and the SMU ±200 V ranges are 
disabled. High-voltage test fixtures require extra precaution to ensure 
there are no shock hazards. 

For correct operation with the Model 4200-SCS, the test fixture 
should have a normally open switch that is used for the interlock. An 
open interlock condition occures when the switch is open. 

 
For the examples shown in this quick start guide, you do not need to 
use an interlock. 

The Model 4200-SCS functions on all current ranges and up to 
±40 volts without asserting the interlock. When the interlock is not 
asserted, the maximum voltage on the SMU and preamp terminals is 
not hazardous. 



 

 

 

To connect the interlock cable: 
1. Connect one end of the supplied interlock cable (part number 

236-ILC-3) to the rear panel of the Model 4200-SCS. The 
location of the rear panel connector is shown in the following 
graphic. 

 
2. Connect the other end of the connector to the test fixture. 
 

Connections for testing 
If you are testing discrete devices, you need a test fixture that is 
equipped with 3-lug triaxial connectors. The Model 8101-PIV test 
fixture that is included with the Model 4200-SCS-PK2 allows the 
Model 4200-SCS to be connected to a discrete device. 

For connections to a probe station for on-wafer testing, see the 
Model 4200-SCS Reference Manual. 

 
The outer shield of the triaxial cables connects the Model 8101-PIV to 
the Model 4200 chassis, which connects to common. 

 



 

  

Make keyboard and printer connections 
1. Connect the printer connection to the USB port or the parallel 

port, as needed for your printer. 

2. Connect the keyboard to the mouse and keyboard connector on 
the rear panel. 

You can also connect an external monitor (user-supplied) to the 
Model 4200-SCS. 
 

Connect the test fixture and DUT to the 
4200-SCS 
To connect the test fixture and DUTs for the: 

 I-V test, see the I-V Test section graphic “Make connections for 
the I-V test.”  

 C-V test, see the C-V Test section graphic “Make connections for 
the C-V test.” 

Power up and log into the instrument 
The 4200-SCS operates from a line voltage of 100 V to 240 V at a 
frequency of 50 Hz or 60 Hz. Make sure the operating voltage in 
your area is compatible. 

The power cord supplied with the Model 4200-SCS contains a 
separate ground wire for use with grounded outlets. When 
proper connections are made, the instrument chassis is 
connected to power line ground through the ground wire in the 
power cord. Failure to use a grounded outlet may result in 
personal injury or death due to electric shock. 

Operating the instrument on an incorrect line voltage may cause 
damage to the instrument, possibly voiding the warranty. 



 

 

To connect line power: 
1. Make sure the front panel power switch is in the off (0) position. 

2. Connect the socket of the supplied power cord to the power 
module on the rear panel. 

 
 

3. Connect the plug of the power cord to a grounded AC outlet. 

4. Turn on the instrument by pressing the front panel POWER 
switch to the ON (|) position. The instrument starts up and 
loads the Microsoft Windows operating system operating system 
and the Keithley Interactive Test Environment (KITE) software. 

 

 

 
The first time you start the KTE-Interactive software tool, the license 
agreement is displayed. You must answer Yes to use the tool.



 

  

Make connections for the I-V test 
If you are using a test fixture, connect the device and 
test fixture as shown in this diagram. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
Item Description Qty Notes 

1 Model 4200-SCS system 1  
2 Model 4200-TRX Ultra Low 

Noise PreAmp Triaxial 
Cable 

2 Triaxial to triaxial cable that 
connects 4200-PA to a test 
fixture 

3 Model 4200-MTRX 1 Ultra low noise SMU 
triaxial cable (mini triaxial, 
connects 4200 SMUs to a 
test fixture) 

4 TG-439 nMOSFET (DUT) 1 Plug into the test socket 
that is labeled DC ONLY  

5 Model 8101-PIV test fixture 1  
6 Model 4200-PA Remote 

PreAmp 
1  

7 Model 4200-SMU module 2  

Perform an I-V test on a MOSFET 
To start a test: 
1. The Project Navigator should be displayed when KITE starts. 

 
If the Project Navigator is not displayed, open the View menu 
and select Project Navigator. 

2. Double-click vds-id (located under 4terminal-n-fet) to display 
the Definition tab in the KITE Workspace. 

 
 

 



 

  

The Definition tab, shown here, is where you define the test. 

 
 

To define the test: 
1. To change the setup for GNDU or a SMU, click FORCE 

MEASURE to display a Settings dialog box. Settings should be: 

 SMU1: Provide a voltage step function for four different gate 
voltages (2 V, 3 V, 4 V, and 5 V).  

 SMU2: Perform a 51-point sweep of drain voltage (0 V to 
5 V) at each gate voltage. A current measurement is 
performed at each voltage sweep point.  

2. Change the settings as needed. 

3. Click Save All (on the toolbar above the Definition tab). 
 



 

 

Run the vds-id test 
KITE can run a single test or a sequence of tests. 

To run a single test, check the test and click it. The test should be 
highlighted. When you click , only that test will run. For example, 
in the following graphic, when you click , only the vds-id test will 
run. 

 
 

To run a sequence of tests, check the tests you want to run, then 
check and click the device, subsite, or project item that contains the 
tests. 

For example, in the following graphic, when you click , all the 
checked tests under 4terminal-n-fet will run: 

 



 

  

In the following example, only one test is run. 

To run the vds-id test: 
1. In the navigator, double-click the vds-id test to highlight it and 

display the data sheets for the test. 

2. On the toolbar, click . 

 While the test is running, the Run Test button turns gray and the 
Abort Test button turns red. In addition, the Measuring indicator 
(on the lower right corner of the front panel) is on. 

3. When the test is complete, the Run Test button turns green. 
 

View results of the vds-id test 
To view data from the vds-id test, you can use the data sheets, which 
are similar to Microsoft Excel spreadsheets. 

To view the results of the vds-id test: 
1. Click the Sheet tab for the test. 

2. Select the tab below the data for the type of information you 
would like to view: 

 Data: Displays the data. 
 Calc: Provides data manipulation and graphing tools similar 

to Microsoft Excel. 
 Settings: Information about the last test that was executed. 

 
 



 

 

Print the results of the vds-id test 
You can print the Data, Calc, or Settings sheet. 

To print one or a few sheets: 
1. Select the sheet. You can also press Ctrl and select multiple 

sheets to print. 

2. Select File, then Print. 

3. Choose Selected Sheets. 

4. Click OK. 

To print the all sheets: 
1. Select File, then Print. 

2. Choose Entire Workbook. 

3. Click OK. 
 

To export the information: 
1. Open the worksheet that contains the data to be exported. 

2. Select Save As ( in the upper right corner). 

3. Choose Entire Workbook. 

4. Click OK. 

5. From the Save As dialog box, specify a file name and path. The 
default directory path for exporting data is 
C:\S4200\kiuser\export. 

6. Click Save. 



 

  

View the graph for the vds-id test 
To display the graph for the vds-id test, click the Graph tab for the 
test.  

A sample graph is shown below. In this example, there are four I-V 
curves – one for each gate voltage. 

Customizing the graph 
The graph was customized to include the Legend box and use 
different colors for the graph series. These options are available 
through the Graph Settings button. 

To customize a graph: 
1. Right-click the graph. The Graph Settings menu is displayed. 

(You can also select the Tools menu and select Graph Settings.) 

2. To include a Legend and Title, select those options from the 
Graph Settings menu. 

 

3. To use different colors for the graph series, select Graph 
Properties, then select Series. The Data Series Properties dialog 
box is displayed.  

 



 

 

4. Select the colors for each series. 

 

 
5. Click OK. The series and color information is displayed. 

 

   



 

  

 
 

Make connections for the C-V test 
If you are using the supplied test fixture, connect the nMOSFET and 
test fixture as shown in this diagram. 

  



 

 

Item Description Qty Notes 
1 Model 4200-SCS system 1  
2 Model CA-447A 4 SMA cable, male to male, 

100 Ω, 1.5 m 
3 Model CS-1391 2 SMA tee adapter 

(female-male-female) 
4 Model 8101-PIV 

Component Test Fixture 
1  

5 8101-309 (nMOSFET with 
S-D-B connected together 
(DUT)) 

1 Plug into PULSE IV test 
socket 

6 Model 4210-CVU Module 1  
 
 
 
 

Perform a C-V test on an nMOSFET 
1. In the Project Navigator, select the cv-nmosfet test. This test is 

located under the 4terminal-n-fet library. 

 

2. Double-click cv-nmosfet to display the Definition tab. 



 

  

The Definition tab, shown in the next graphic, is where you define 
the test. In the test shown in this Definition tab, the device is 
connected to the CVH1 and the CVL1 terminals of the 
Model 4210-CVU. The default setting shows the DC bias is swept 
from 5 V to −5 V in 0.2 V steps, with a 1 MHz capacitance 
measurement taken at each step. 

Note that the device used for this test has source, drain, and bulk 
connected through the drain lead of the device. 

 
 



 

 

Run the cv-nmosfet test 
To run the cv-nmosfet test: 
1. In the Project Tree, make sure the cv-nmosfet test is checked and 

highlighted. 

2. On the toolbar, click . 

 While the test is running, the Run Test button turns gray and the 
Abort Test button turns red. In addition, the Measuring indicator 
(on the lower right corner of the front panel) is on. 

3. When the test is complete, the Run Test button turns green. 
 

View results of the cv-nmosfet test 
To view data from the cv-nmosfet test, you can use the data sheets, 
which are similar to Microsoft Excel spreadsheets. 

To view the results of the cv-nmostfet test: 
1. Click the Sheet tab for the test. 

2. Select the tab for the type of information you would like to view: 

 Data: Displays the data. 

 Calc: Provides data manipulation and graphing tools similar 
to Microsoft Excel. 

 Settings: Information about the last test that was executed. 

 



 

  

Print results of the cv-nmosfet test 
You can print the Data, Calc, or Settings sheet. 

To print one or a few sheets: 
1. Select the sheet. You can also press Ctrl and select multiple 

sheets to print. 

2. Select File, then Print. 

3. Choose Selected Sheets. 

4. Click OK. 

To print the all sheets: 
1. Select File, then Print. 

2. Choose Entire Workbook. 

3. Click OK. 
 

To export the information: 
1. Open the worksheet that contains the data to be exported. 

2. Select Save As ( in the upper right corner). 

3. Choose Entire Workbook. 

4. Click OK. 

5. From the Save As dialog box, specify a file name and path. The 
default directory path for exporting data is 
C:\S4200\kiuser\export. 

6. Click Save. 
 
 



 

 

View the graph for the cv-nmosfet test 
To display the graph for the cv-nmosfet test, click the Graph tab for 
the test. 

A sample graph is shown here. In this example, the C-V curve is 
measured between the gate and the source/drain/bulk. Notice that 
the COX, CFB, and VFB parameters are extracted and displayed on 
the screen. 

You can customize graphs with options that are available through the 
Graph Settings menu. 

 



 

  

FAQs 
My data looks odd or is wrong. What should I do? 

Verify the connections from the instrument to the test fixture. 
Also check the connections from the DUT to the test fixture 
socket. 

The Run Test button is not green 

You cannot run the selected test if the Run Test button ( ) is not 
green. This can occur: 

 If a test is still running. 
 The check box for the test is cleared. 
 Changes to the test setup were made but not saved. 
If a selected test will still not run, click the Status tab for the test. 
The tab provides status information for the test. 
 

I cannot unplug the mini triaxial cable (Model 4200-MTRX) 
from the SMU 

The mini triaxial connector is a locking connector. To remove it, 
pull the knurled part of the connector back. 

A configuration error has been detected and I cannot launch 
KITE 

This occurs when the physical configuration does not match the 
KCON-defined configuration or when there are communication 
problems between instruments and the Model 4200-SCS. Run 
KCON; from the Tools menu, select Validate Configuration to 
verify the system configuration.  

This can also occur if the PreAmp or RPM is removed or 
reconnected. In this case, you must update the system 
configuration. Run KCON; from the Tools menu, select Upgrade 
PreAmp and RPM Configuration. 

Note that PreAmps are SMU-specific. For example, a PreAmp that 
is configured for SMU1 cannot be connected to SMU2. 

 
 



 

 

Next steps 
See the Model 4200-SCS Complete Reference, which is 
preinstalled on your system. To access the Complete Reference, 
click Help in the KITE menu. You can also press F1. 
The Model 4200-SCS Complete Reference includes the following 
documents: 
 Model 4200-SCS User Manual: Contains basic information 

about using the system, plus application-based examples that 
will help familiarize you with the instrument. 

 Model 4200-SCS Reference Manual: Provides detailed 
information about all features of the instrument. 

 Application notes: Detailed applications that demonstrate 
specific applications. 

 Data sheets: Technical data regarding the 4200-SCS and 
related accessories. 

 

 Keithley Instruments website 
See www.keithley.com for support and additional information 
about the instrument 
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